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Dear Students!! 

In this e-book of 12th class, study material of computer science 

is being sent to you as per new syllabus (2024-25). You can 

easily prepare your test / papers by reading these notes and 

watching the video lectures given below. Following are the 

links of the video lectures in blue colour. Watch these video 

lectures by clicking on the relevant link of chapter to have 

better understanding of various concepts. 

12th Class - Monthly distribution of Computer Science Syllabus & Video Lecture Links (Pbi) 
 

Month Chaper & Its Name  Link of Video Lecture 

April Chapter-1 Office Automation & Typing (Explanation) https://youtu.be/HEJpX01IwpM 

 Chapter-1 Office Automation & Typing (Solution) https://youtu.be/LwOpv8j92bo 

May Chapter -2 Control Statements (Explanation) https://youtu.be/T6zvUn61x-k 

 Chapter -2 Control Statements (Solution) https://youtu.be/JXe2kGAJ7WY 

July Chapter -3 Computer Networks https://youtu.be/6YULI1naDZI 

Aug Chapter -4 Current Trends in Information Technology https://youtu.be/YHtjpOWi-ZY 

Oct Chapter -5 Artificial Intelligence & Expert System https://youtu.be/rvn2FpS1PKQ 

Nov Chapter -6 Digitialization https://youtu.be/galuEBdTkuI 

Dec Chapter -7 E Governance (Part-2)  

Jan Chapter -8 Image Editing & File Conversion Tools  

Feb Chapter –9 Audio & Video Editing  
 

Practical Video Lectures for Chapter -2 (Control Statements)  

C Language Practical -1      https://youtu.be/8hg3BJAyBqE 

C Language Practical -2      https://youtu.be/v_lw8wmfIP4 

C Language Practical -3      https://youtu.be/RBq--darc0I 
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https://youtube.com/playlist?list=PLja3EaJFAjmYjeAcDs0ZQdVmx7liCtg5P 
 

PLEASE DO NOT FORGET TO LIKE, SHARE AND SUBSCRIBE OUR YOUTUBE CHANNEL 

http://youtube.com/c/computersciencepunjab 
 

Prepared By: 

Vikas Kansal and Sukhwinder Singh 

Computer Faculties, S.U.S. Govt. (G) Sen. Sec. School, Sunam Udham Singh Wala (Sangrur) 

Please use the following link to download the study material/e-books/e-contents for 6th to 

12th classes: 

http://cspunjab.nirmancampus.co.in/study.php 

https://youtu.be/HEJpX01IwpM
https://youtu.be/LwOpv8j92bo
https://youtu.be/T6zvUn61x-k
https://youtu.be/6YULI1naDZI
https://youtu.be/YHtjpOWi-ZY
https://youtu.be/rvn2FpS1PKQ
https://youtu.be/galuEBdTkuI
https://youtu.be/8hg3BJAyBqE
https://youtu.be/8hg3BJAyBqE
https://youtu.be/v_lw8wmfIP4
https://youtu.be/v_lw8wmfIP4
https://youtu.be/RBq--darc0I
https://youtu.be/RBq--darc0I
https://youtube.com/playlist?list=PLja3EaJFAjmYjeAcDs0ZQdVmx7liCtg5P
https://youtube.com/playlist?list=PLja3EaJFAjmYjeAcDs0ZQdVmx7liCtg5P
https://youtube.com/playlist?list=PLja3EaJFAjmYjeAcDs0ZQdVmx7liCtg5P
http://youtube.com/c/computersciencepunjab
http://youtube.com/c/computersciencepunjab
http://cspunjab.nirmancampus.co.in/study.php
http://youtube.com/c/computersciencepunjab


12th Class Computer Science (Session 2024-25) 

 

Vikas Kansal (Computer Faculty, S.U.S. Govt. Girls Sen. Sec. School, Sunam Udham Singh Wala)  1 | P a g e  

Chapter 1st 

Office Automation and Typing 

Que:1 Multiple Choice Questions: 

1. _________________ is word processor software. 

a. MS Window  b. MS Excel   c. MS PowerPoint  d. MS Word 

2. To check spelling and grammar _________________ key is used. 

a. Ctrl+F7   b. Alt+F7   c. F7    d. Shift F7 

3. _________________ option in Word changes the structure and layout of pages. 

a. Format   b. Print and Print Preview c. Page Setup   d. Proofing 

4. ______________ is an electronic spread sheet software used for automated calculations. 

a. MS Window  b. MS Excel   c. MS PowerPoint  d. MS Word 

5. ______________ refers to changing the font style, size, color, bold, italic, underline and other 

related parameters. 

a. Formatting   b. Alignment   c. Proofing   d. Filtering 

Que:2 Fill in the Blanks: 

1. _________ and ________ Functions used to find the minimum and maximum value in a range. 

2. Filter option is available in ____________ tab of Excel. 

3. If the cursor is placed at the end of the file, then __________ button is pressed to delete the text. 

4. Two options of orientations for page setup are ________ And __________  

5. _________ Symbol is used to start any formula (function) in excel calculations. 

Ans: 1. MIN, MAX  2. Data 3. Backspace  4. Portrait, Landscape 5. = (Equals to) 

Que:3 Write Shortcut Keys 

I. For copying contents    Ctrl+C 

II. For Paste     Ctrl+V 

III. For Bold     Ctrl+B 

IV. For Underline    Ctrl+U 

V. For Center Alignment   Ctrl+E 

VI. For Justify Alignment   Ctrl+J 

VII. For Double Line Spacing   Ctrl+Shift+D 

VIII. For Replace     Ctrl+H 

IX. For Printing     Ctrl+P 

X. For Spelling and Grammer Check  F7 

 

Que:4 Short Answer Type Questions.  

Q:1 What is Excel? 

Ans: Microsoft Excel is a powerful electronic spread sheet program. Usually, we can use it to 

automate accounting work, organizing data, and for performing a wide variety of tasks. We can use it 

to prepare results, doing mathematical calculations and representing data in pictorial form with the 

help of charts. 

Q:2 Explain formatting in details? 

Ans: Formatting refers to changing the font style, for example: increasing or decreasing the font size, 

performing bold, italic and underline operation on text. We can change the appearance of text and 

graphics with the help of formatting options. Text Formatting options are available on the Home tab 

in MS Word/Excel/PowerPoint. 

 
Q:3 Explain Print & Print Preview options. 

Ans: Print preview is a feature that displays on the screen what a hard copy would look like when 

printed. When we click the Print option in File menu, it automatically will show the preview of our 

document. It means Print Preview option is used to preview our document on the screen before 

https://www.computerhope.com/jargon/h/hardcopy.htm
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getting its hard copy while Print command is used to get the hardcopy of our document by printing it 

on the paper.  
 

 
 

Q:4 What are formulas in MS Excel? 

Ans: In MS Excel, Formulas are used to perform different types of calculations. Formulas can be used 

to perform different types of calculation for preparing results and fee related data. In Excel, a 

formula always begins with equals to (=) symbol. Usually, we use cell references in formulas along 

with the operators to perform calculations. Some of the examples of formulas are: 

=D15+D18+D21    

=(B16+C16)*1.07  

Q:5 What do you know about the formula bar in Excel? 

Ans: Formula Bar is one of the most important components of MS Excel. The Formula Bar is 

available at the top of the Excel window, just below the ribbon area. The Formula Bar has two parts: 

left and right side. Left side is Name Box which shows the name or address of current selection while 

right side shows the contents of the currently selected cell. 

 
 

Q:6 What are Margins? 

Ans: A margin is the space between the contents and the edge of our document. 

We can set the margins at all the sides (Top, Bottom, Left, Right) of the page. By 

default, a new document's margins are set to Normal, which means it has a one-

inch space between the contents and each edge. Word allows us to change 

the margin size in our document as per our requirement. 
 

Que:5 Long Answer Type Questions. 

Q:1 What are Word Processors? Explain their uses. 

Ans: A word processor is an application software that is used to prepare different types of documents. 

MS Word and WordPad are the common examples of word processors. Common uses of Word 

Processors are explained below: 

 To prepare documents, letters etc. 

 To format the documents. 

 To prepare letterheads for personal and business purpose. 

 To design different types of documents such as resumes or invitation cards etc. 

Print Preview 

Print 

Formula 
Bar 

Margin 
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Q:2 Describe the Proofing options in MS Word? 

Ans: Word can also proof read our document to highlight other possible mistakes. For example: 

misplaced commas or correctly spelled words that may be used incorrectly etc can be highlighed using 

Proofing option. To make word proof read our document, Click the Proofing icon at the bottom of the 

document window. Following are the options that can be used for proofing: 

 Auto Correct: This option helps us to replace a misspelled word  with the correct one 

automatically during typing text. 

 Spelling and Grammer: MS Word also helps us to find and correct grammer and spelling 

errors in our document. Word displays a red wavy line under the misspelt word while green 

wavy line is used to show the gramatical error in the document. A new blue wavy line has also 

been added in the new versions of word which represents the formatting inconsistency. For 

checking and correcting spelling and grammer mistakes, function key F7 can be used. 

 
Q:3 Explain the Page Setup and Printing Options available in Excel. 

Ans: Page Setup allows us to change the structure and layout of pages in a document. The “Page 

Setup” group on the “Page Layout” tab contains buttons that allow us to make changes in the page 

setup of document. Using these options, we can change the margins, page orientation (portrait or 

landscape), paper size (A4, Legal, Letter) etc. We can do these operations using the Page Setup dialog 

box. This dialog box can be opened by clicking on the dialog launcher icon present at the bottom-right 

corner of Page Setup group. 

 
Printing options include Print Preview and Print commands. Print preview is a feature that displays 

on the screen what a hard copy would look like when printed. When we click on Print option in File 

menu, it automatically shows the preview of our document. It means Print Preview option is used to 

preview our document on the screen before getting its hard copy while Print command is used to get 

the hardcopy of our document by printing it on the paper. 

 

Proofing 
option 

Print Preview Print 

https://www.computerhope.com/jargon/h/hardcopy.htm
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Q:4 What are functions in Excel? Explain any two functions with example. 

Ans: A function is a predefined formula that performs calculations using specific values in a 

particular order. Excel includes many common functions that can be used to quickly perform 

calculations, for example: SUM, AVERAGE, COUNT, MAX and MIN etc. Following is the 

explanation of two functions: 

 MAX: This function is used to find the largest numeric value from a range of values. It ignores 

empty cells, the logical values TRUE and FALSE, and text values. Example: =MAX(A1:C1) 

 MIN: This function is used to find the smallest numeric value from a range of values. It ignores 

empty cells, the logical values TRUE and FALSE, and text values. Example: =MIN(A1:C1) 

Q:5 Explain the various methods of Typing? 

Ans: Typing is the process of writing or inputting text by pressing keys on a typewriter, computer 

keyboard, cell phone, or calculator. Text can be in the form of letters, numbers and other symbols. 

For typing on computer system, we can use the following techniques: 

 Touch Typing: Touch typing is a technique by which we can learn typing with all fingers, step 

by step, without having to look down at the keyboard. It helps us to increase our typing speed. 

Any typing-tutor software can be used for learning this technique. 

 Voice Typing: In this type of typing technique, speech recognition programs are used for typing 

that converts spoken words into text. Voice-to-text technique was originally developed as an 

assistive technology for the visually impaired or handicapped persons. For typing in punjabi 

language, we usually use Lipikar punjabi app in mobiles. 

Chapter 2nd 

Control Statements 

Q:1 Objective Type Multiple Choice Questions: 

1. Which of the following statement is also called as conditional statement? 

a. for   b. break  c. if    d. while  

2. switch-case is similar to ________________ statement 

a. if else  b. if else if  c. break   d. goto  

3. Which statement can be used to terminate a case in the switch statement? 

a. continue  b. goto   c. if    d. break 

4. Which of the following is an example of Post Test loop? 

a. for   b. while  c. do while   d. continue 

5. Which of the following is not a jumping statement? 

a. while  b. continue  c. goto    d. break 

Q:2 Fill in the Blanks: 

1. In ____________ loops, the control conditions are tested before the body of loop 

2. In ____________ loops, the control conditions are tested after the body of loop 

3. ______________ statement is used to skip some statements inside the loop 

4. _______________ is a multi-way conditional control statement 

5. The break statement can be used to terminate a case in the _________ statement. 

Ans: 1. Pre-Test 2. Post-Test  3. continue  4. Switch case  5. switch 
 

Q:3 Write True or False 

I. Writing if statement with-in another if is called Nested Loop. 

II. Control statements in C programming are used for altering the normal flow of a program. 

III. continue statement is sometimes desirable to skip some statements inside the loop? 

IV. Looping statements provide a way to repeat commands? 

Ans:  I. False  II. True  III. True  IV. True 
 

Q:4 Short Answer Type Questions: 

Q:1 Define Branching? Name its different control statements? 

Ans: Those control statements which are used for decision making purpose or for making multi-way 

selection in the program are called Branching Statements. These statements choose to follow one 
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branch or another during execution in the program. Branching statements are of the following two 

types: 

 Conditional Control Statements (if else) 

 Multiway Conditional Control Statement (switch case) 

Q:2 What is looping? Name three different types of looping statements? 

Ans: Those control statements which are used to repeat a set of statements in the program are called 

looping statements. Looping statements are also called Iterative Statements. Following three looping 

statements are used in the C programming: 

 for loop 

 while loop 

 do while loop 

Q:3 What is nested if statement? Write its syntax? 

Ans: When one if statement is used within another if statement, it is 

known as nested if statement. Syntax of nested if statement is shown in 

the figure.  

Q:4 What is if-else statement? Write a program of if-else statement? 

Ans: if else statement is a branching statement. It is used for decision making purpose in the C 

programs. Following program shows the usage of if else statement: 

 
Q:5 What is while statement? Write its syntax? 

Ans: while statement is a looping statement. It is used for repeating set of 

statements in the program. It is a type of pre-test loop in which test condition is 

tested before the execution of body of the loop. The syntax of the while 

statement is shown in the given figure.  
Q:5 Long Answer Type Questions: 

Q:1 What are Control Statements? Explain their types. 

Ans: When a program executes line by line in the given sequence, it is called Sequential Execution of 

the program. We can control this execution flow in the program as per our requirements. Those 

statements that control the flow of execution of statements in the program are called Control 

Statements. These statements can be classified into following 

three categories: 

 Branching Statements (if else and switch case) 

 Looping Statements (for, while and do while) 

 Jumping Statements (goto, break and continue) 

Q:2 What is for loop? What are the two different categories of loops? 

Ans: Looping statements are also called Iterative Statements. Sometimes we face situations that 

require repeated exection of statements in the program. In such situtaions, loops help us to repeat 

statements in the program. Loops can be categorized into 

following two types: 

 Pre-Test Loops: Pre-Test loops are also called Entry-

Controlled loops. In these loops, test condition is 

tested before the body of the loop. ‘for’ and ‘while’ 

loops are the examples of pre-test loops. 

 Post-Test Loops: Post-Test loops are also called Exit-

Controlled loops. In these loops, test condition is 

tested after the body of the loop. ‘do while’ loop is an 

example of post-test loop. 
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Q:3 What is jumping statement? Explain its types? 

Ans: Jumping statements in the C progamming are used to change the normal execution flow of the 

program. We can transfer the exection flow from one location to some other location in the program. 

Following jumping statements are used in the C programming: 

 goto statement: For using these statements, we have to use labels in the program. This 

statement transfers the execution control at the label specified after the goto statement. 

 break statement: This statement is used to terminate the exection of a loop or switch statement 

and transfter the execution control immediately after the loop or switch statement. 

 continue statement: Sometimes it is benficial to skip statements in the loop. continue statement 

is used in such situtations. 

 
 

Q:4 What is do while loop? How it differs from while loop? 

Ans: ‘do while’ loop is a post test loop. The ‘do while’ loop is the only loop which is known as the post-

test loop in C programming. In ‘do while’ loop, test-condition is tested after the exection of body of the 

loop. In this loop, minimum number of executions for the body of the loop will be one. It is so because 

whenever this loop is executed for the first time, its body gets executed without executing the test-

condition of the loop. 

‘do while’ loop is different from the ‘while’ loop. ‘while’ loop is a pre-test loop in which test condition 

is tested before the execution of body of loop. The minimum number of executions for the body of the 

loop will be zero. It is so because whenever this loop is executed, its body can not be executed without 

executing the test-condition even once. 

 

 

Chapter 3rd 

Computer Networks 

Que:1 Multiple Choice Questions: 

1. A computer _______________ is a set of computers that are connected together. 

a. Network   b. System   c. Protocol   d. Internet 

2. A _______________ is basically a multiport repeater. 

a. Hub    b. Switch   c. Router   d. Bridge 

3. A _______________ is a 2-port device. 

a. Hub    b. Switch   c. Router   d. Bridge 

4. Wi-Fi stands for_______________   

a. Wireless Field  b. Wireless Fidelity  c. Wire Fire      d. Wire Fidelity 

5. A _______________ is a combination of a Bridge and a Router. 

a. Switch   b. Bridge   c. Hub    d. Brouter 
 

Que:2 Write Full Forms  

1. UTP   Unshielded Twisted Pair 

2. FTP   File Transfer Protocol 

3. SMTP   Simple Mail Transfer Protocol 

4. POP   Post Office Protocol 

5. HTTP   HyperText Transfer Protocol 

6. MAC   Media Access Control 
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Que:3 Fill in the blanks: 

I. There are total __________ layers in the OSI Model 

II. ___________layer of OSI model manges device addressing. 

III. In _________ media, data is transmitted using cables.  

IV. Bluetooth is an example of ____________ media. 

V. In __________ communication mode, data communication is unidirectional. 

Ans: I. Seven (7) II. Network  III. Guided  IV. Unguided  V. Simplex 

Que:4 Short Answer Type Questions. 

Q:1 What is a Network? 

Ans: Networks are the base of communication in Information Technology. A 

Computer Network is a set of two or more computers which are connected with 

each other using some communication media. This communication media can 

be either guided or unguided. Computer networks are used to share 

information, for communication or to perform some other tasks.  
Q:2 Write the different types of OSI layers. 

Ans: OSI stands for Open System Interconnection. ISO develops a 7 layered model for 

communication between computer systems in a network. Each layer performs its designated function. 

These 7 layers are: 

1. Application Layer 

2. Presentation Layer 

3. Session Layer 

4. Transport Layer 

5. Network Layer 

6. Data Link Layer 

7. Pyhsical Layer 

Q:3 What is a Bridge? 

Ans: Bridge is a network device. This device is used to connect 

two different ethernet networks. This device uses MAC 

addresses to forward data packets in a network.  It only 

forwards packets from one network to another concerned 

network. This device has only one input port and only one 

output port. Hence this device is also called 2-port device. 

Q:4 Why do we need a network? 

Ans: Following are some of the important reasons why we need a network: 

 To Communicate information (using email, video, instant messaging). 

 To share different types of hardware devices (such as printers, modems, etc.). 

 To share files. 

 To share software and operating systems available on remote systems. 

 For network users so that they can easily access and manage information. 

Q:5 What is guided media? 

Ans: Guided media is a type of transmission media. Using this media, data 

is transferred using cable wires. This media transfers data through a 

particular fixed path. Examples of commonly used guided media are: 

 Twisted pair cable 

 Co-axial cable 

 Optical fiber cable 

Q:6 What is un-guided media? 

Ans: Unguided media is also a type of transmission media. Using this media, data is transferred 

through air without using cable wires. This type of communication is often referred to as wireless 

communication. In this media, data transfer can take place in any direction instead of a fixed path. 

Examples of commonly used unguided media are: 

 Infrared 

 Bluetooth 

 Wi-Fi 

 Radio waves 

 Microwaves 

 Satellites 
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Q:7 Define Protocol. 

Ans: Network protocols are a set of rules. These rules control the exchange of information in an easy, 

reliable and secure way. Any kind of data transfer over the network or the Internet is possible only 

with the help of these protocols. TCP/IP, FTP, SMTP, HTTP, etc. are examples of some commonly 

used network protocols.  

 

Que:4 Long Answer Type Questions. 

Q:1 What are network devices? Describe any three network devices. 

Ans: Network device refers to the hardware devices that are used to build a network. Different types 

of network devices are used for different types of networks, such as: switches, hubs, routers, bridges, 

gateways, brouters, etc. Following is the description of some of the major network devices: 

 SWITCH: This device connects the various devices in 

a network, such as computers, printers, routers, or 

other switches, so that these devices can communicate 

with each other. 

 ROUTER: This device is used to connect our network 

to the Internet. It is a switch-like device that sends 

data packets to the network based on its IP address. 

 BRIDGE: This device is used to connect two different 

Ethernet (LANs) networks. It uses the MAC address to forward data packets to the network. This 

device has only one input port and only one output port. That is why it is also called 2-port device. 

Q:2 What is Unguided Media? Explain any two media. 

Ans: Unguided media is a type of transmission media. Using this media, data is transferred through 

air without using cable wires. This type of communication is often referred to as wireless 

communication. In this media, data transfer can take place in any direction instead of a fixed path. 

Bluetooth, WiFi, Radio Waves, Satelites etc. are the examples of Unguided Media. 

 WiFi: Full Form of WiFi is Wireless Fidelity. It is a popular wireless networking technology. 

Using this technology, we can exchange wireless information between two or more devices 

connected to the same network. 

 Bluetooth: It is a kind of radio communication technology. It enables short-distance wireless 

networking between phones, computers and other networking devices. The process used to 

connect two Bluetooth devices is called "pairing". 

Q:3 What is a Twisted Pair Cable? Define its advantages and disadvantages. 

Ans: Twisted pair cable is a guided transmission media. It is used to transmit data across a network. 

This cable consists of two different insulated copper wires, which are twisted together. The first wire 

is used for data transfer and the second wire is used for grounding (earthing). The wires are twisted 

together to reduce cross-talk. 

Advantages of Twisted Pair Cable: 

 These cables can be used for both analog and digital broadcasting. 

 These cables are cheap for short distances. 

 If any part of the network is damaged, the entire network is not down. 

Disadvantages of Twisted Pair Cable: 

 The signal cannot travel over the long distances without the use of repeaters. 

 These wires are very thin and break easily. 

Q:4 What is Fibre Optic Cable? Define its advantages and disadvantages. 

Ans: Optical fiber cable is a guided transmission media. It is used 

to transmit data across a network. It transfers digital data signals 

in the form of light. This cable is made up of many thin flexible 

optical fibers. Each fiber is made up of three layers: 

 Core: It is made up of high-quality silica glass or plastic. 

 Cladding: It is also made up of high-quality silica glass or 

plastic. 

 Buffer: It is an outer protective cover made of plastic. 
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Advantages of optical fiber: 

 It is suitable for industrial and noisy areas. 

 Its data transfer rate is very high. 

 It can be used to transfer data over hundreds of miles. 

Disadvantages of optical fiber: 

 Optical fiber cables are expensive. 

 These wires are not easy to use. 

 

Q:5 What is Communication Mode?  Define its types in detail. 

Ans: Communication mode is also known as transmission mode. Transmission mode is the process of 

transferring data or information between two devices connected within a network. There are three 

types of communication modes: 

 
 Simplex mode: In this mode of communication, the communication is 

unidirectional. Only one of the devices in this mode can send a signal 

and the other can only receive a signal. For example: Communication 

between keyboard and computer. 

 Half-duplex mode: In this communication mode, the flow of 

communication can be in both directions, but only one device is 

capable of communicating at a time. For example: In a walkie-talkie, 

sender speaks on one side and the receiver on the other side listens and 

then after a pause, another speaks and the first person listens. 

 Full duplex mode: Even in full duplex mode, the flow of communication is in both directions, but 

communication is possible in both directions at the same time. This is the fastest mode of 

communication between devices. For example: Communication between two people using mobile 

phones. 

 

Chapter 4th 

Current Trends in Information Technology 

Que1: Multiple Choice Questions 

1. Information Technology (IT) is an area under which computers or other physical devices 

(hardware, software) are used to create, _______, secure and exchange electronic data. 

a. Access   b. process   c. define   d. save 

2. With the introduction of online education services, students can learn from anywhere using the 
__________ 

a. Internet         b. electricity              c. 5G Technology              d. email   

3. Android operating system is a _________ operating system. 

a. Computer         b. Mobile   c. Technology              d. Virtual reality 

4. Cloud computing is a kind of ____________based computing. 

a. Big-data        b. IoT    c. Internet             d. Bluetooth 

 

Que:2 Write the Full form of following 

1. Wi-Fi  : Wireless Fidelity 

2. VR  : Virtual reality 

3. IoT   : Internet of Things 

4. IT   : Information Technology 

5. GPS  : Global Positioning System 
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Que:3 Fill in the blanks 

I. __________ is a technology that uses radio waves for wire-less high speed internet and 

network-coinnections. 

II. _____________ means experiencing things through our computer that do not really exists. 

III. M.Commerce is also known as __________ Commerce 

IV. ____________ storage is a way of saving digital things online. 

Ans: I. WiFi  II. Virtual Reality  III. Mobile  IV. Cloud 

 

Que:4 Short Answer Type Questions. 

Q:1 What is Information Technology? 

Ans: Information technology is a technology in which computers or other devices are used to create, 

process, store and exchange electronic data. Information technology is such a field of any organization 

or business that does all the operations related to computers and technology. 

Q:2 Give name of any four current trends in Information Technology. 

Ans: Following are the names of current major trends in information technology: 

 WiFi technology 

 Bluetooth technology 

 E-commerce 

 GPS technology 

 Android technology 

 Internet of Things (IoT) 
 

Q:3 Define Bluetooth Technology. 

Ans: Bluetooth is a type of radio communication technology that allows 

all types of media files to be sent or received wirelessly. It enables short-

distance wireless networking between phones, computers and other 

devices. The process used to connect two Bluetooth devices is called 

"pairing". 
 

Q:4 Define GPS Technology. 

Ans: The full name of GPS is Global Positioning System. GPS is available in every smartphone today. 

GPS is used to find the geographical location of any place. It is a global navigation satellite system. We 

can use it to find the distance or route between two places. When we send our live location to someone 

on WhatsApp, we are using GPS. 

 
Q:5 What do you know about E-Commerce? 

Ans: E-commerce stands for Electronic Commerce. It is also known as Internet Commerce. It is a way 

of doing business using the internet. With the use of this technology, buying or selling of goods and 

services is possible through the Internet. In this technology, two or more parties exchange data and 

money electronically. Examples of E-Commerce websites are Amazon, Flipkart etc. 

Q:6 Define 5G technology. 

Ans: 5G technology means 5th generation technology. 5G is the next generation of wireless 

technology. This technology is much better than 2G, 3G and 4G technologies. The 5G technology 

based mobile networks will connect people as well as connect and control machines and devices. In 5G 

technology, the speed of internet can be 100 times faster than 4G technology. Its internet speed will be 

more than 20 Gbps so that large amount of data can be easily downloaded and uploaded within a very 

short time span. 
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Que:4 Long Answer Type Questions. 

Q:1 What is Information Technology? Describe the various applications of Information Technology? 

Ans: Information technology is used in every field of human life. Here is a description of some of the 

application areas of information technology: 

 Business: Information technology is used in business to run it smoothly. 

 Online education: In online education, students can get education from anywhere by using 

internet. 

 Health: Information technology has greatly improved the field of health. Information technology 

is used to manage lab test results, patient records, etc. 

 Transportation: In the field of transportation, information technology is used for various 

purposes, such as: booking railways and airplane tickets from home, availability of seats, travel 

time, etc. 

 Telecommunications: Information technology has opened the door to new telecommunication 

services, such as: exchanging information via email, video conferencing etc, 

 Entertainment: The computer has become an important tool for watching movies, listening 

music and playing games etc. 

Q:2 Describe Android Technology with its advantages. 

Ans: Android is an operating system. It is used for mobile devices. It was 

developed by the Open Handset Alliance and later supported by Google. 

It was later used for touch screen devices, cellphones and tablets. 

Benefits of Android:  

 It is compatible with different platforms, such as Windows, Linux operating system, etc. 

 It supports different media, such as: MP3, MP4 etc. 

 It supports various technologies, such as: Camera, Bluetooth, Wi-Fi etc. 

 It supports multi-tasking. 

 It can be used easily. 

Q:3 Describe Internet of Things (IoT) with its advantages 

Ans: The Internet of Things or (IoT) is a new technology that focuses on making human life more 

comfortable. The Internet of Things (IoT) is a cyber physical system that uses sensors to collect data 

from the physical world. It is a network of interconnected digital devices and objects. The Internet of 

Things (IoT) aims to connect everyday devices, such as ACs, refrigerators, TVs etc. to the Internet. 

Some of the benefits of the Internet of Things (IoT): 

 IoT devices work automatically so it makes human work easier. 

 All devices are more secure as they are automatic and technical. 

 They definitely save a lot of human time due to high mechanical processing. 

 We and our home appliances - cameras etc. stay connected to each other through this 

technology. 

 Our home appliances can be turned on and off automatically, which helps in efficient use of 

electricity and energy. 

Chapter 5th 

Artificial Intelligence and Expert System 

Que1: Multiple Choice Questions 

1. Who brought the concept of AI? 

a) Victor Allis      b) Marvin Minsky c) Alan Turing      d) John McCarthy 

2. Which type of AI focuses on single set of abilities &performs a particular task? 

a) Super AI          b) Narrow AI              c) General AI      d) None of these. 

3. Which one of AI type does not have memory for data storage 

a) Limited Memory      b) Reactive machines     c) Things of Mind    d) Self Awareness 

4. The core of the expert system which by applying set of rules and draw the results of the user 

question is the function of 

a) Inference engine b) Knowledge base c) User Interface  d) None of these 

5. Place where knowledge from the human expert is collected 

a) Domain expert b) Knowledge Base c) User d) All of these 
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6. Robots which provides help for analyzing the collected data are 

a) Healthcare robots b) Domestic robots c) Military robots d) Research robots 

 

Que:2 Fill in the Blanks: 

1. Artificial Intelligence is divided into two types __________ and ____________ 

2. ____________ is a chess playing computer developed by IBM. 

3. __________ is a good example of narrow artificial intelligence. 

4. ____________ machine have no memory. 

5. MYCIN and _______ are examples of earlier expert systems. 

6. __________ Generation Robots are smart as humans. 

Ans: 1. Type-1, Type-2   2. Deep Blue   3. Apple Siri 

 4. Reactive    5. Dyndral   6. Fourth 

 

Que:3 Write the Full form of following: 

1. AI  Artificial Intelligence 

2. GAI  General Artificial Intelligence 

3. NLP Natural Language Processing 

4. SAI Strong Artificial Intelligence 

 

Que:4 Short Answer Type Questions 

Q:1 What is artificial intelligence? 

Ans: Artificial Intelligence (AI) means the artificial development of intellectual ability. AI is a branch 

of computer science that enables machines to work as intelligently as humans. Artificial intelligence 

develops smart machines to make human life easier and more comfortable. Some examples of 

Artificial Intelligence (AI) are: robots, smart cars, drone systems, Alexa, etc. 

Q:2 What are the types and subtypes of AI? Depict them with the help of diagram. 

Ans: The following diagram shows types and subtypes of Artificial Intelligence: 

 
Q:3 What do you mean by expert systems? Give examples of expert systems. 

Ans: Expert systems are computer software. These softwares fall under the category of Artificial 

Intelligence which is a branch of computer science. These softwares are primarily developed using AI 

technology. Such software systems have specialized knowledge of a particular field, subject or skill. 

Here are some examples of expert systems: 

 DENDRAL: This is an expert system for chemical analysis. 

 MYCIN: This expert system specializes in the treatment of blood infections. 

Q:4 What is the difference between human system and expert system? 

Ans: The differences between the human system and the expert system are as follows: 

Human System Expert System 

1. Its capacity decreases with time. 1. Its capacity is permanent. 

2. Human outcomes cannot be 

predicted. 

2. The results obtained from these are 

consistent. 

3. They are difficult to transfer. 3. They can be easily transferred. 

4. Human experts are expensive. 4. It is a cheaper alternative than a human 

being. 
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Q:5 Summarize about some computer languages used in the field of AI? 

Ans: Computer Languages used to develop Artificial Intelligence are as follows: 

1. PYTHON: This language is widely used in the field of Artificial Intelligence. 

2. LISP: LISP is a very old language for the development of AI. It was developed in 1958 by John 

McCarthy, the father of AI. 

3. PROLOG: This language is used to work on medical projects and is also used extensively to 

develop Expert Systems. 

4. JAVA: Java can also be considered as a good option for the development of AI. 

5. R: This language is a good choice for statistical analysis. 

Que:5 Long Answer Type Questions. 

Q:1 What are the applications of artificial intelligence? 

Ans: The major application areas of artificial intelligence are described below: 

1. AI is used to build Intrusion Detection Systems. For example, a firewall program in the operating 

system that automatically blocks unauthorized websites. 

2. AI is used in the Gaming field. In particular, it plays an important role in strategic games such as 

chess, tic-tac-toe. 

3. AI plays an important role in systems that process Natural Languages. For example: human 

interactive computer systems that can understand and process human language. 

4. AI is used to create Vision Systems. These systems are able to understand and analyze the visual 

input on the computer. Example: Spy Drones 

5. AI is used in building Expert Systems. 

6. AI is used to make Intelligent Robots. 

7. AI is used in building Machine Learning Systems. 

Q:2 What is the importance of AI? 

Ans: There are many areas of importance for artificial intelligence. Here is a brief description of some 

of these key areas: 

1. Game Playing: AI plays an important role in strategic games like Chess, Poker, Tic-Tac-Toe etc. 

For example: Deep Blue machine developed by IBM for playing the game of chess. 

2. Voice recognition: AI technology recognizing words spoken by the user and convert them into the 

text or prerform some operations. It is also called Speech Recognition System. For example: 

Apple's Siri software also provides voice recognition and answers to questions asked by users. 

3. Understanding Natural Language: AI is used to understand and analyze natural languages 

(Punjabi, Hindi, English etc.). The main function of natural language processing is to translate, 

analyze grammar, etc. For example: Dragon Dictation, Voice Text Messaging, Alexa etc. 

4. Computer Vision and Analysis: AI plays an important role in computer vision. This system 

automatically gathers and provides information from pictures and patterns. For Example: Spy 

Drones 

Q:3 What are the Pros and Cons of Artificial Intelligence? 

Ans: The advantages and disadvantages of artificial intelligence are described below: 

Benefits of Artificial Intelligence: 

1. AI-based systems increase performance. These systems perform complex tasks without errors. 

2. AI based systems can work for a long time without having rest. These systems are not as sick as 

human beings and do not take leave. 

3. Machines are emotionless so emotional interruptions cannot stop machines or robots to work. 

4. There is no possibility of error in the operation of these systems. 

5. These systems can operate in hazardous areas where human life is in danger, such as: work in 

deep mines, work in space, etc. 

Disadvantages of Artificial Intelligence: 

1. There is no sympathy in machines. 

2. Excessive use of these systems will increase unemployment. 

3. If these systems break down, important data stored in them will also be lost. 

4. These systems can be misused if they fall into the wrong hands. 

Q:4 Discuss the characteristics of expert systems? 

Ans: Following are some of the import characgeristics of Expert System: 
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 Expertise: Expert systems specialize in a specific area. For example, the MYCIN Expert System 

specializes in the treatment of blood infections. 

 Quick Reaction Time: Expert Systems provide quick answers to the questions being asked from 

them. 

 Reliability: No mistakes are made by the expert system, so they are trustworthy. 

 Decision Quality: Expert systems are capable of making high quality decisions. 

 Consistent: Expert systems always give same answer for the same questions. 

 Low cost: It reduces the cost of consulting a specialist for various areas such as: medical 

examination. 

 Successful Model of Artificial Intelligence: Expert System is a successful model of Artificial 

Intelligence. 

Chapter 6th 

Digitization 

Que:1 Multiple Choice Questions: 

1. ____________ is the process to convert information into computer readable form. 

a) E-learning   b) E-commerce  c) Digitization d) Net Banking 

2. ________ is meant to be online buying and selling of goods. 

a) E-commerce  b) Digi Locker  c) Digital Payment d) None of these 

3. Easiest and convenient way for cashless payment is ________. 

a) Digitization  b) Storage   c) Offline  d) Digital Payment 

4. _______________ stores only those educational certificates, issued by educational institutes through 

digital mode. 

a) SWAYAM   b) NAD   c) MOOCs  d) DigiLocker 

5. ___________ is a type of e-commerce which involves company and customer. 

a) B2B    b) B2C   c) C2C   d) None of these  

Que:2 Write the full forms: 

I. B2B Business to Business 

II. B2C Business to Consumer 

III. C2C Customer to Customer OR 

Consumer to Consumer 

IV. NAD National Academic Depository 

V. UPI Unified Payment Interface 

Que:3 Short Answer Type Questions. 

Q:1 What is digitization? 

Ans: Digitization means the process of converting information into digital medium. Converting 

information to a digital medium means converting information into a computer readable and 

manageable form. In digital media, information is stored in bits. Nowadays pictures, documents, 

audio, video, etc. can be converted to digital medium with the help of various devices. Examples of 

digitization are land records, Aadhaar cards, e-books etc. 

Q:2 Describe Net Banking. 

Ans: Net-banking is also called internet-banking. Using Net Banking, we can easily perform a variety 

of banking activites from home at any time, such as: 

 View our bank account statement 

 Make a variety of online payments 

 Pay bills 

 Transfer money to other accounts, etc.  

Q:3 What do you mean by E-Commerce. 

Ans: E-commerce stands for Electronic Commerce. It is also known as Internet Commerce. It is a way 

of doing business using the internet. With the use of this technology, buying or selling of goods and 

services is possible through the Internet. In this technology, two or more parties exchange data and 

money electronically. Examples of E-Commerce websites are Amazon, Flipkart etc. 

Q:4 Name types of E-Comemerce. 

Ans: Following are the names of types of e-commerce: 

1. Business to Business (B2B) 

2. Business to Consumer (B2C) 

3. Consumer to Consumer (C2C) 

4. Consumer to Business (C2B) 
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Q:5 Write down the benefits of online payment. 

Ans: The main benefits of online payment are as follows: 

1. Online payment is a very easy and convenient way to transact money. 

2. With this facility, there is no need to keep more cash in our pocket.  

3. Due to online payment, we can easily make money transactions anytime and anywhere. 

4. There are various concessions offered by the government on digital payments to promote digital 

payments. This returns a small percentage of what we have paid back to our account. 

Q:6 Describe Digi Locker. 

Ans: DIGILOCKER is a secure way to store all our important documents online. We need to register 

online to store documents on Digilocker. Our account is linked to Aadhaar card during registration. 

This account provides 1GB of cloud storage to the person concerned. In Digilocker, we can store other 

documents besides educational documents like Aadhaar card, driving license etc. 

Q:7 What is e-learning? 

Ans: E-learning is also called Electronic-Learning or Online Learning or Online Education. E-

learning means getting online education. It is an easy and comfortable way to get an education. Using 

this learning method, we can study online courses from home. The exam is also given online. After 

passing the examination, the certificate can also be downloaded from the website of the concerned 

institution. Course related materials like e-books, video or audio lectures etc. are also provided online 

by the concerned institute. MOOCs, SWAYAM, SWAYAM-PRABHA, PSEB E-BOOKS etc. are some 

of the important popular e-learning tools. 

Q:8 What is digital or online payment? 

Ans: Online payments are also called Digital Payments or E-Payments or Electronic Payments. This is 

an easy and fast way to make cashless payments. Both the payer and the receiver use digital media. 

Money transfer, purchase of goods, payment of bills, etc. can be done easily through digital payment. 

Credit-card, debit-card, e-wallet, net-banking, Bhim app etc. can be used for online payment. 

Que:4 Long Answer Type Questions. 

Q:1 Write down the types of e-commerce in detail. 

Ans: E-commerce can be divided into four main types: 

 Business to Business (B2B): In this type of e-commerce, different companies do their business 

with each other. This type of e-commerce involves only manufacturers, wholesalers and 

retailers. 

 Business to Consumer (B2C): It includes companies and consumers. Through this mofrl og r-

commerce, companies provide their products and services directly to 

their consumers. Examples: Amazon, Flipkart, eBay etc. 

 Consumer to Consumer (C2C): In this type of e-commerce, 

Consumers are in direct contact with each other and no company is 

involved. In this model, people can sell and buy their personal 

belongings to each other. It is usually used by people to sell their 

surplus or second-hand goods. For example: OLX, Quikr etc. 

 Consumer to Business (C2B): In this type of e-commerce, consumer provides his goods or 

services to the company. Example: An individual develops his own software and sells it to a 

company. 

Q:2 Write down the advantages and disadvantages of e-commerce. 

Ans: The advantages and disadvantages of e-commerce are described as follows: 

Benefits of e-commerce: 

1. E-commerce companies can provide their goods or services anywhere in the world. 

2. E-commerce saves a lot of money as we can buy directly from the manufacturing company, 

which eliminates many taxes and additional costs. This is how we get the product at a lower 

price. 

3. Purchased goods are delivered to the consumer in the shortest possible time by the companies 

directly to the address given by the consumer. 

4. Shopping can be done at any time through e-commerce. Business never stops here. 
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5. From the long list of items on e-commerce websites, we can select any item to purchase very 

easily. 

Disadvantages of e-commerce: 

1. Items purchased through e-commerce are not immediately received by the customer, as it takes 

a few days for the e-commerce company to deliver the goods to the customer's given address. 

2. The quality of the item purchased through e-commerce is known to the customer when he 

receives the item. 

3. E-commerce websites store important customer details and information. If this information is 

obtained by an unauthorized person, the customer may suffer heavy financial or personal loss. 

Q:3 Give brief note on various digital or online payment modes. 

Ans: There are many ways to pay online. Here is a description of some of the major online payment 

methods: 

1. Credit Cards: This is a plastic card issued by banks to their customers. When the customer 

makes a purchase using this card, the concerned bank pays for that purchase. The customer has 

to repay the payment made by the bank within the stipulated time.  

2. Debit Cards: Like a credit card, it is a plastic card. When a customer pays by debit card, the 

payment amount is immediately deducted from the amount deposited in the customer's account. 

3. E-Wallets: This method of payment uses digital payment apps. These apps store the customer's 

credit, debit card or bank account information so that payments can be made easily. Paytm, 

JioMoney, Google Pay etc. are some of the major e-wallet apps. 

4. Net Banking: Net-banking is also called internet-banking. Using Net Banking, we can easily 

perform various banking related activities at any time from home. It also allows us to make 

different types of online payments. 

5. BHIM App (Bharat Interface for Money): BHIM is a mobile app. It's an easy and fast way of 

payment. Payment is made by using the UPI ID of the person concerned or by scanning the QR 

Code. 

 

Chapter 7th  

E Governance (Part-II) 

Que:1 Multiple Choice Questions: 

1. The online service of government is called- 

a) Public welfare services   b) democracy services   c) E-governance  d) internet services 

2. G2C Stands for – 

a) Government to employee   b) Government to citizens   

c) Government to business man  d) Government to government 

3. The modern form of E-Governance services is: 

a) E-Business b) E-Commerce  c) E-Services  d)Smart governance 

4. How many digits are there in Aadhar card number? 

a)  14  b) 12  c) 16  d) 10 

5. Which one is the part of information system? 

a) Database and procedures    b) network  c) Hardware and software  d) All of these 

 

Que:2 Fill in the blanks: 

1. The services and facilities of E-governance is divided into ______________ parts. 

2. ______________ gives a unique identity to Indian citizens. 

3. In Punjab at village level ________________ Gives E-Governance services. 

4. ________________ is used to solve difficult problems. 

5. Smart cards are symbol of __________________ 

Ans:  1. Three 2. Aadhar number 3. Suvidha Centers 4. Expert System 5.Smart Governance 

 

Que:3 Write Full forms: 
I. UIDAI Unique Identification Authority of India 

II. G2G Govterment to Government 

III. G2E Government to Employee 

IV. MIS  Management Information System 

V. DSS  Decision Support System 
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Que:4 Short Answer Type Questions. 

Q:1 What are the three levels of E-governance? Give detail. 

Ans: The different levels of E-Governance system are as under: 

1. National Level 

2. Domestic Level / State Level 

3. International Level 

Q:2 In brief describe Smart Governance? 

Ans: The modern name of e-governance is Smart Governance. ‘Smart’ means attractive and 

governance means to govern. In simple words, the use of new technology for better planning and 

better decision making in a democratic system is called smart governance. It deals with ways to 

improve democratic processes and provide better public services through the use of technology. 

Q:3 Write down any four uses of Aadhar card? 

Ans: Here are some key uses of Aadhaar Card: 

i. To open a bank account. 

ii. To get gas connection and subsidy. 

iii. To get a mobile SIM card or telephone connection. 

iv. To avail various welfare schemes. 

v. As a unique identification document. 

Q:4 What are the different parts of information system? 

Ans: The components of an information system are as follows: 

 Hardware: This component monitors, CPUs, keyboards, mice, printers, hard disks etc. 

 Software: This component includes all programs that process data using hardware. 

 Database: This component is used to store data. 

 Network: This part is used to share resources, information and data. 

 Procedure: This component includes the methods and processes to obtaine information from data. 

Q:5 What is the Sewa/Suwidha Kendra? Describe. 

Ans: The government has opened many help-desks at different levels 

(districts, tehsils, blocks, cities, villages) to provide e-services and 

facilities through e-governance. These support centers are called Sarva 

Sewa Kendras or Sewa Kendras. These centers provide various e-

services to the citizens, such as: issuance of residence certificate, caste 

certificate, birth-death certificate, etc.  

Que:5 Long Answer Type Questions 

Q:1 What do you mean by E-Governance? Define its working system? 

Ans: E-Governance is a functional system in which governments, citizens and organizations 

participate in the online facilities and services. All of them perform their activities using the internet 

in different ways. The workings of e-governance can be explained under the following sections: 

 
1. G2G (Government to Government): This type of e-governance includes online services in which 

the Central Government and the State Governments share data and information with each 

other. 

2. G2C (Government to Citizen): In this form of e-governance, the government provides services 

and facilities to its citizens. These services are free or provided at very low cost. Such as: online 

payment of bills, online payment of income tax etc. 

3. G2B (Government to Business): This type of e-governance provides services and facilities to 

businesses by the government. For example: online services related to online sales, purchase of 

goods, taxes on goods and subsidies etc. 
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4. G2E (Government to Employee): In this form of e-governance, the government provides services 

and facilities to its employees. Such as: online services for pay-bills of employees, maintenance of 

their service records, departmental transfers etc. For example: iHRMS 

5. G2N (Government to NGOs) / Government to NGOs: In this type of e-governance, services and 

facilities are provided by the government to NGOs. For example: Online registration of NGOs 

or societies etc. 

Q:2 What are the benefits and limitations of E-Governance? 

Ans: The advantages and disadvantages of e-governance are as follows: 

Benefits of e-Governance: 

1. People can easily get e-governance services online or at their nearest Service or Suwidha 

Kendras. 

2. With the advent of e-governance, government work has also accelerated. 

3. E-Governance reduces the cost of documentation. 

4. e-Governance has created a transparent environment in the working style of all offices. 

5. The concerned officer or employee is liable for any delay in work. 

Disadvantages of e-Governance: 

1. Uneducated or technically ignorant people cannot avail these services properly. 

2. We must have Internet access to use these services. 

3. Opening a service center in every village is an expensive task. 

4. The Internet cannot be considered completely secure. 

Q:3 What is Aadhar card? Describe its characteristics?  

Ans: Aadhaar is a unique 12-digit identification card number. This 

number is issued to Indian citizens by UIDAI (Unique Identification 

Authority of India). No two people in India can have the same Aadhaar 

number. Basic characteristics of aadhar card are as follows: 

1. Unique Identity: Aadhaar provides a unique identity to every Indian citizen. 

2. Residential document: The complete residential address of the person concerned is printed on it. 

3. No expiration date: There is no expiration date of Aadhaar card. 

4. Identity Proof: Since the Aadhaar card contains personal and biometric information of the 

person, it can be used as proof of identity. 

5. Online Authentication: Nowadays authentication is done only through Aadhaar card number 

for various types of online facilities. 

Q:4 Write down the list of services provided by Sewa/Suvidha Kendra? 

Ans: Following are some of the online services and facilities offered by the service centers: 

1. Issuance of residency certificate 

2. Issuance of Caste Certificate 

3. Issuance of birth and death certificate 

4. Issuance of income certificate 

5. Issuance of Aadhaar Card 

6. Issuance of Certificate of Religion 

7. Issue copies of registry, mutations. 

8. Issuance of Vehicle Registration (RC) Certificate 

9. Filling up old age/widow pension forms 

10. Issuance of driving license 

11. Submitting electricity, telephone and many other types of bills online. 
 

Chapter 8th 

Image Editing and File Conversion Tools 

Que:1 Multiple choice question: 

1. ______________ tool allows us to select a drawing with a free hand. 

a. Fuzzy Selection  b. Lasso  c. Text    d. Bucket Fill 

2. SHIFT + C is a shortcut for ________________ 

a. To Create Duplicate Image   b. To Delete Layer 

c. To Copy of an image    d.  To Crop an Image 
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3. Scale option is used to change the _____________ of an image. 

a. Color   b. Size   b. Area   d. All of the above 

4. ______________ is known as group of sheets looking at each other. 

a. Masking   b. Tools  c. Layers   d. None of the above 

5. ______________ helps to make a duplicate copy of the active layer 

a. Smudge Tool  b. Dodge Tool  c. Perspective Tool  d. Duplicate Layer 
 

Que:2 Fill in the blanks:  

1. To resize the layer _____________ tool is used. 

2. To move the layers _____________ tool is used. 

3. The quality of the picture decreases when the picture is _____________ 

4. An important part of the Image Window is ____________ where the picture is shown. 

Ans:   1. Scale   2. Move  3. Scaled  4. Canvas 
 

Que:3 Write shortcut Keys:  

I. For Creating a New File   Ctrl+N 

II. For Opening a File    Ctrl+O 

III. For Creating duplicate Image  Ctrl+D 

IV. For Viewing Image Properties  Alt+Enter 

V. For Cropping the Image   Shift+C 

VI. For Merging Layers   Ctrl+M 
 

Que:4 Short Answer Type Questions. 

Q:1 What is Image Editing? 

Ans: The image editing process is also called image re-touching. It is a process by which we make 

required changes to the images stored in digital format. We often make these changes to make the 

pictures look better. While editing the image, we can perform various tasks on the image such as: 

enlarging or shrinking the image size, adjusting the brightness and contrast, crop, rotate, flip etc. For 

these tasks we use image editing software in the computer. For example: Photoshop, GIMP, etc. 

Q:2 What are Layers? 

Ans: Layers means Stack of Slides. Layers are groups of sheets that appear on top of each other. An 

image is composed of multiple layers. Layers can be set one above the other. In GIMP, we can 

perform many operations related to layers, such as: insert, delete, merge layers, etc. 

Q:3 How can a duplicate image be made? 

Ans: Following are the steps to make a duplicate copy of image in GIMP: 

1. Click on the Image menu. 

2. Click on the Duplicate option 

Duplicate copy of image can also be made using shortcut key CTRL + D. 

Q:4 Write two ways to open the picture. 

Ans: Here's how to open a pre-created image in GIMP: 

1. Click on File → Open    

2. Open dialog box will appear. Select the image that we want to open and click on the Open 

button.  
 

Que:4 Long Answer Type Questions. 

Q:1 Write down the names of any 4 tools of GIMP and explain the usage. 

Ans: Following is the description of 4 commonly used GIMP's tools: 

1. Eraser Tool: This tool is used to erase the area of the current layer. This tool can be activated by 

clicking on the Eraser icon at the Tool Box or by using SHIFT + E. 

2. Text Tool: This tool is used to write text on pictures. Click on the Tools → Text command to use 

this tool or it can be activated by clicking on the A symbol in the Tool Box. 

3. Move Tool: This tool is used to move selection (to change position), i.e. text, layers etc. Click on 

the Tools → Transform Tools → Move command to use this tool or click the Move Tools icon 

from the Tool Box. 

4. Scale Tool: This tool is used to scale layers, objects, i.e. to change their size. Click on the Tools → 

Transform Tools → Scale option or SHIFT + S command to use this tool. 
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Q:2 How to resize a picture in GIMP? 

Ans: Sometimes we need to resize the image, i.e. increase or decrease the width or height of the image. 

Modifying these dimensions of the image is called resizing. The steps to resize the image are as 

follows: 

1. Click on the Image menu. 

2. Click on Scale Image. 

3. The Scale Image dialog box opens. Change the Width and Height values as required.  

GIMP also allows us to set the measurement units such as px, percentage, centimeters, meteres, 

inches, feet etc. 

 

Chapter 9th 

Video Editing 

Que:1 Fill in the Blanks: 

1. In order for the computer to play audio files, different _________ are required. 

a. Video codecs   b. Audio Codecs   c. Both a & b    d. None 

2. _________ format is a common audio format that is played extensively on electronic devices. 

a. wmv    b. avi     c. mp3    d. cda 

3. Audio files are stored on the Audio CD in _______ format. 

a. flv     b. aac     c. mov    d. cda 

4. The effect applied between two video-clips is called ____________  

a. sound    b. video    c. video transition   d. photo 

5. The process of dividing the video into sections is called ______________  

a. merging    b. splitting    c. compressing   d. decompressing 

 

Que:2 Write True or False: 

1. The process of making a movie is divided into five stages.     False 

2. Video editing works with only one video clip.       False 

3. Merging a video means splitting the clip into several parts.     False 

4. It is advisable to save the project before starting the process of exporting video file. True 

5. MPEG-4 video format uses different compression for audio and video tracks.  True 

 

Que:3 Write the Full Forms of the Following: 

1.  MP4   Moving Picture Experts Group-4 

2.  WMV   Windows Media Video  

3.  FLV   Flash Video 

4.  AVI   Audio Video Interleaved 

 

Que:4 Short Answer Type Questions. 

Q:1 Write the names of the three stages of making a movie. 

Ans: The task of making a movie is usually divided into three stages: 

 Pre-Production 

 Production 

 Post-Production 

 

Q:2 Write down the names of some video editing software. 

Ans: The following are some of the popular video editing software: 

 For Windows operating systems: Filmora Pro, Windows Movie Maker, Adobe Premiere Pro CC 

 For Android (ANDROID) operating system: Adobe Premiere Pro, KineMaster, Viva Video 

 

Q:3 What are Audio Converters? 

Ans: Audio converters are software used to convert one audio file format to another. These softwares 

require CODECS to complete this conversion. Some popular audio converter software are: Xilisoft 

Audio Converter, Switch Audio Converter, Format Factory, Fre:ac etc. 
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Q:4 What are codecs? 

Ans: A codec is a file or program used to Compress and Decompress a digital media file. The codec 

can be divided into two parts: Encoder and Decoder. The Encoder compresses the media and the 

decoder decodes it. Some codecs contain both of these components and some codecs contain only one 

of them. For example: When a song is Riped from an audio CD to a computer, Windows Media 

Player compress the song in the .WMA (Windows Media Access) format by default using the audio 

codec. When the .WMA file is played, Windows Media Player decompress the file using the audio 

codec to play the audio properly. 

 

Q:5 What do you mean by Video Split? 

Ans: Sometimes we need to remove unwanted part of a video from the beginning or end of the video 

or we need to delete a part of the video in between. Video cutting is the process of changing the length 

of a video as required. Here are some keywords related to video cutting: 

 Trim: Using trim operation, we can remove a part of the video from the beginning or end. 

 Cut: It means to cut a part of a video clip. 

 Split: When a long video is divided into smaller parts, this process is called splitting the video. 

 

Que:5 Long Answer Type Questions. 

Q:1 What are Tracks? 

Ans: When we Import a video in Video Editing Software and insert it into the tracks, the video is 

divided into two parts: Visual and Audio. The visual part contains only video (without sound) and the 

audio part contains only sound. These video and audio sections are housed in separate video and 

audio tracks, where we can edit them. All video editing software provides separate tracks for audio 

and video and we can add as many tracks as we need. Tracks are very useful when we need to edit a 

specific part of an audio / video. It is not possible to put two clips on the same track at same place. If 

we want to include audio as well as our video, we still need to use more than one track. 

 

Q:3 Explain the difference between Video Transitions and Video Effects. 

Ans: Video transitions are the effects applied to a video. These effects are applied between two objects. 

A video transition controls how another video or picture will be displayed after one video clip or 

picture has been played in the movie. We can apply transition effects between two images, video clips 

or titles. Storyboards or timelines are used to insert transition effects. This transition takes place after 

one clip is finished and before the next clip starts. We can also set the transition time according to our 

requirements. 

 

Q:3 Write in more detail: Storyboard, Timeline, Titles. 

Ans: Storyboard, Timeline and Titles can be explained as follows: 

 Storyboard: This is a panel of pictures or other video clips to create the story of the movie. It 

shows the sequence of photos and video clips that will appear in the movie. We can re-arrange 

pictures or videos by placing them in the storyboard. It also shows transition effects. 

 Timeline: This is used to edit the timing of clips in our project. Audio clips included in the movie 

project are not displayed on the storyboard. They can be viewed in the timeline panel. In the 

timeline view, we can trim the clips. It can also include tracks as needed. 

 Titles: Titles help us to enhance our movie by adding text-based captions to the movie. We can 

add titles to the movie to show any kind of information, such as movie name, movie release date, 

cast names, etc. We can also apply animation effects to the titles to make the movie more 

attractive. 


